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Section 3 
 

Formulas 

By the end of this Section you should be able to: 

Create Simple Formulas 

Understand Mathematical Operators 

Use Brackets 

Calculate Percentages 

Select Cells with the Mouse to Create Formulas 

Understand Ranges 

Use AutoSum 

Copy and Paste Formulas 

Use the Fill Handle 

Check Formulas for Errors 
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Exercise 12 - Introducing Formulas 

Guidelines: 

A calculation in Excel is called a Formula. Formulas are used to calculate 
answers from numbers entered on the sheet, e.g. add a column of numbers, total 
sales for the year, calculate net profit in a month, etc. Formulas automatically 
calculate results from the data. The original data can be changed, but the formula 
will automatically recalculate. This allows results to be projected from different 
data, but using the same formula. All formulas begin with an equals sign (=), 
followed by the calculation. Cell references are used in formulas in Excel. 

Actions: 

1. Open the workbook Calculations that was created in Exercise 7. If you 
have not completed Exercise 7, create the layout shown below, placing 
your own name in cell A1 and leaving cell D4 empty for the moment. 

2. The contents of cells B4 and C4 are to be added together. Click on cell D4 
to make it the active cell. Type =b4+c4, without leaving spaces (the + 
symbol on the numeric keypad at the right of the keyboard may be used for 
the add sign). Ignore any menus that may appear. 

Note: To use the numeric keypad for number entries, the Num Lock light must be on. 
If it is not on, press the <Num Lock> key. When entering cell references, like 
B4, it does not matter if they are entered in capitals or not, as Excel converts 
them to uppercase. 

 
3. Complete the formula in D4 by pressing <Enter>. 

4. Click back on cell D4 and notice that the answer to the calculation, 250, is 
displayed in the cell, while the actual cell contents =B4+C4 are displayed 
on the Formula Bar. 

 
5. Save the workbook as Calculations2 and leave it open. 
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Exercise 13 - Mathematical Operators 

Guidelines: 

The basic mathematical operators are add, subtract, multiply and divide. The 
symbols on a keyboard are slightly different to those used normally and are: 

+ Add 

- Subtract 

* Multiply 

/ Divide 

These symbols appear twice on the keyboard, one set placed around the main 
keyboard and the other set on the numeric keypad (right side). The numeric 
keypad is easier to use because the keys are closer together and the <Shift> key 
is not needed. 

Other mathematical operations are used via Functions, covered in a later 
Section.  Office 2007 has a Function Library group on the Formulas tab which 
contains the most used functions. 

Actions: 

1. The workbook Calculations2 should still be open from the previous 
exercise. If not, open it. 

2. The number in cell C5 is to be subtracted from the number in cell B5. Make 
cell D5 the active cell and enter the formula =b5-c5. Complete the entry by 
pressing <Enter>. Cell D5 should display the answer 150. 

3. Cell D6 will be used to multiply together the contents of cells B6 and C6. 
Enter the formula =b6*c6 into cell D6. The answer should be 10000. 

4. Cell D7 will be used to divide the contents of cell B7 by the contents of cell 
C7. Make cell D7 the active cell and enter the formula =b7/c7. Cell D7 
should display the answer 4. 

 

5. Save the workbook and close it. 
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Exercise 14 - Brackets 

Guidelines: 

When more than one operator is used in a single formula, then the order 
becomes important, e.g. D23+E17/E19. Excel performs calculations in this 
order: Brackets over Division, Multiplication, Addition and finally Subtraction (the 
BODMAS  theory). So in this example E17 would be divided by E19 then added to 
D23. Brackets are added to force Excel to perform calculations in a different 
order. 

Actions: 

1. Start a new blank workbook and create the spreadsheet layout shown 
below. 

 

2. The profit per unit is calculated by subtracting the Bought at price from the 
Sold at price. The overall profit per product may then be calculated by 
multiplying the profit per item by the number of units sold. Make cell B7 the 
active cell and enter the formula =b4-b5*b6. 

3. Press <Enter> and the answer is displayed as -185, a loss! This is 
because Excel follows the BODMAS theory and carries out the 
multiplication (10*20=200) before the subtraction (15-200=negative 185). 

4. To correct the situation delete the contents of cell B7 and re-enter the 
formula as =(b4-b5)*b6 <Enter>. 

5. Notice how the brackets ensure that the subtraction (15-10) is carried out 
first and then the multiplication (5*20), so that the correct answer of 100 is 
displayed. 

6. Save the workbook as Brackets and leave it open. 

 
 
 
 

continued over 



Excel 2007 CLAIT Plus 

 31 © CiA Training Ltd 2007 

Exercise 14 - Continued 

7. Click the Sheet2 tab. Enter the following data, starting at cell B2. 

 
8. In cell C6, the total income will be calculated by multiplying the Price by 

Number e.g. 20 by 2 and 30 by 5 and then adding these together, then 
dividing by 100 to give the price in pounds. Enter the formula 
=B3*C3+B4*C4/100. 

 
9. The answer is £41.50, which is not correct. Brackets must be used to 

make sure Excel performs the calculations in the right order, e.g. the 
multiplications first, the addition second and the division last. 

10. Click on cell C6 and press the <Delete> key. 

11. Now enter the correct formula, =((B3*C3)+(B4*C4))/100 (Brackets are 
always used in matching pairs). 

 
Note: When brackets appear inside other brackets, the inside brackets are always 

calculated first. In the example, the two multiplications are calculated first, then 
added together and finally the division is performed. 

12. Save the workbook and leave it open for the next exercise. 
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Exercise 15 - Selecting Cells with the Mouse 

Guidelines: 

When entering formulas that involve the use of cell references, e.g. =E6+F6 or 
even =GZ1207+GZ1208 typing errors can be made. The mouse can be used to 
enter the cell references. This is also called Pointing. The mouse pointer is 
moved to the required cell and clicked. 

Actions: 

1. The workbook Brackets should still be open from the previous exercise. If 
not, open it. Click the Sheet1 tab. 

2. Make cell C3 active and enter the label Product 2. 

3. In cell C4 enter a Sold at price of 20. 

4. In cell C5 enter a Bought at price of 10. 

5. In cell C6 enter the Number value of 15 

6. Make cell C7 active and begin a formula by typing =( then instead of typing 
the cell reference, click on cell C4 to enter the reference into the formula. 

 
7. Use the keyboard to enter a - sign and then click on cell C5. Type )* and 

then click on cell C6. Press <Enter> to complete the formula and confirm 
that C7 displays the correct result of 150. 

 
The Formula Bar shows the formula and the cell the answer 
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8. Save the workbook and close it. 
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Exercise 16 - Percentages 

Guidelines: 

Percentages are displayed with a percentage symbol, e.g. 25%. A percentage is 
a fraction or decimal displayed differently. Percent means per hundred. 20% is 
20/100 as a fraction or 0.2 as a decimal. 

There is a Percent Style button, , that changes a decimal to a percentage. 

Actions: 

1. Start a new workbook and create the following worksheet. 

 
2. To display the first number as a percentage of the second in D3, enter the 

formula =B3/C3 using any method. 

3. To format the answer as a percentage, click the Percent Style button,  
from the Number group on the Home tab. 

4. Change the second number to 27 and press <Enter>, notice that the 
percentage value changes automatically. 

5. To display percentage with two decimal places, make the active cell D3 and 

click in the Format Number box drop down, , in the 
Number group and select Percentage to display the cell as 55.56%. 

6. Add the following data starting at cell B5. 

 
Note: To enter 50% in cell C6, type 50 followed by the percent key <Shift 5>, or enter 

0.5 and use the Percent Style button. 

7. To find 50 percent of 20, in cell D6 enter the formula =B6*C6. The answer 
is 10 (half of 20 is 10). 

8. Enter 86 in B6 and 45% in C6. Press <Enter> to display the answer, 38.7. 
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9. Close the workbook without saving. 
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Exercise 17 - Ranges 

Guidelines: 

A Range is a rectangular collection of cells. Just as single cells are identified by a 
cell reference, ranges are identified by the cells of their outer limits, e.g. the four 
cells B2, B3, C2 and C3 is the range B2:C3. 

Ranges are selected by pressing the mouse button and holding it down, then 
dragging to highlight a range of cells (called click and drag). Entire rows or 
columns can be selected by clicking the row or column headings. By clicking and 
dragging the row or column headings, groups of rows or columns can be 
selected. 

Actions: 

1. On a new worksheet, point and click on cell B2 and with the mouse button 
held down, drag down and to the right so that a range of four cells is 
highlighted, as shown below. 

 
2. Release the mouse button. Notice that the first cell in the range contains the 

cell reference (is white) and the other cells are highlighted in pale blue. 

3. Click anywhere on the worksheet to remove the selected range. 

4. More than one range can be selected by pressing <Ctrl> whilst clicking and 
dragging. Select the range B2:C3 again. Press and hold down the <Ctrl> 
key. Click and drag the range C5:D6.  Release the <Ctrl> key. There 
should now be two separate ranges highlighted. 

 
5. Click anywhere on the worksheet to remove the selected ranges. 

6. Click on the B in the column heading. Column B is now highlighted. Click 
anywhere to deselect it. 

continued over 
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Exercise 17 - Continued 

7. Click and drag in the row heading, from 5 to 7. The three rows are selected. 
Click anywhere on the worksheet to remove the selection. 

8. When selecting a range the mouse control has to be very precise. 
Sometimes the range is not exactly the right one, it may be 1 row or column 
short. Click and drag the range C3:G7. 

9. The range can be extended by holding down the <Shift> key and clicking 
on a cell to extend the range. Hold <Shift> and click on cell G9. The range 
is extended. 

10. Click anywhere on the worksheet to remove the selection. 

11. A range can be selected without dragging using the above method. Click on 
cell B2, hold <Shift> and click on cell G12, to select the range B2:G12. 

Note: If the range is larger than the screen, stay in the grey areas next to the worksheet 
if dragging, as the selection process is very fast if the pointer touches the edge of 
the screen. 

12. Select the range C5:Z5 by dragging. Deselect the range. 

13. Select the same range C5:Z5 by clicking in cell C5, scrolling across to 
column Z, holding <Shift> and clicking in cell Z5. 

14. Close the workbook without saving. 
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Exercise 18 - AutoSum 

Guidelines: 

The most common formula is addition. This calculation has been simplified by 
the creation of a Function called Sum. Functions (covered in full in a later 
Section) are pre-created formulas. There are buttons on the Ribbon called 
AutoSum that creates the Sum function automatically. 

Actions: 

1. Open the workbook Sandwiches. This should have been created earlier, if 
not, go back to Exercise 4 and re-create the spreadsheet layout. 

2. Click on cell F4. A formula needs to be entered here that will add up the 
contents of the four cells B4, C4, D4 and E4. Using the mouse to select 
each of the cells, enter the formula =B4+C4+D4+E4. 

3. This method of adding cell contents soon becomes unusable, as more 
numbers need to be added. To avoid the creation of long and unwieldy 
formulas, a function: SUM is available within Excel to add together the 
contents of a group of cells. A button is provided on the toolbar to perform 
this function automatically. Make cell B9 the active cell. 

4. Display the Formulas tab and 
click the AutoSum button, 

 in the Function 
Library group. 

Note: There is also an AutoSum button on 
the Home tab in the Editing group, 

. 

5. AutoSum scans vertically upwards, searching for cells containing 
numbers. It identifies the numbers in cells B4 to B8 and uses those cell 
references to create the function =SUM(B4:B8). Since this is the correct 
calculation, press <Enter> to accept the function and display 98. 

6. Make cell F4 active and click  to replace the existing formula. 
This time AutoSum scans vertically upwards but there are no numbers 
above so it scans left and identifies the range of cells from B4 to E4 
inclusive. Press <Enter> to complete the function. The answer should be 
99, the same as displayed by the original formula. 

Note: AutoSum only works without any help when numbers have already been entered 
into the worksheet. If AutoSum has numbers in both directions it will sum 
upwards by default. 

7. The other totals will be added in a later exercise. Save the workbook as 
Sandwiches2 and close it. 
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Exercise 19 - Copy and Paste 

Guidelines: 

Rather than repeatedly typing the same data into several cells, the data can be 
copied and then pasted. 

The Copy command can be used to copy labels, values and formulas.  The 
selected cells are placed in an area of Windows  called the Clipboard, from 
where they can then be Pasted back into other locations. 

Actions: 

1. Start a new workbook. 

2. Make the cell B3 active and type HELLO <Enter>. 

3. To copy this cell, click on cell B3 and then click the Copy button,  from 
the Clipboard group on the Home tab. 

Note: An alternative method is to press <Ctrl C>. 

4. The selected cell will now have a broken border (called a Marquee) and the 
message Select destination and press ENTER or choose Paste is 
displayed in the Status Bar. 

5. Click on cell B7 and press <Enter>.  The contents of B3 will now be 
pasted into B7. The contents of B3 remain unchanged.  Note that B3 no 
longer has a broken border. 

6. Enter 65 into cell C6, select the cell and click the Copy button, . 

7. Move to B9 and click the Paste button, . Note that C6 still has a broken 
border, indicating that its contents can be pasted again if required. 

Note: A Paste Options Smart Tag, , will be displayed next to the pasted range. 
Clicking on this tag would display a selection of options concerning the paste 
process. These are not covered in this guide. 

Note: An alternative method is to press <Ctrl V>. 

8. Move to B10 and paste again. 

9. Press <Esc> to end the pasting and remove the marquee around C6. 

10. Close the workbook without saving the changes. 
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Exercise 20 - Using the Fill Handle 

Guidelines: 

Ranges can be quickly filled with data by using the Fill Handle, which appears 
when the cursor is placed over the bottom right corner of the active cell. Cell 
contents can either be copied or used as the basis for a numeric series. 

 
It is only possible to drag in one direction, i.e. along a row or down a column. 

An extra feature of dragging the Fill Handle is the ability to automatically fill 
ranges with series such as months of the year, days of the week and dates. 

Actions: 

1. Open the workbook Sandwiches2. 

2. Click on the Sheet2 tab to view a blank sheet within Sandwiches2. 

3. Type your first name into cell B2. Complete the entry. 

4. Select B2 again and move the mouse pointer to the Fill Handle of B2. 
Click and drag the cell along to G2. 

5. In E4 enter 63. Click and drag the Fill Handle of E4 across to I4. The entry 
63 is repeated. 

6. Click the cell E4 again. Hold <Ctrl> while dragging the Fill Handle to cell 
E9. 

 

7. Release the mouse button to fill the cells with increasing numbers. This 
method is very useful for quickly numbering cells, especially rows. 

8. In A10 enter January. Click and drag the fill handle of A10 along to H10. 

9. In A13 enter 1st. 

10. Click and drag the fill handle of A13 down to A22. This is very useful when 
creating calendars. 

Fill Handle 
(Black +) 
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continued over 
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Exercise 20 - Continued 

11. Click the Sheet1 tab to display the sandwich sales data. 

12. Formulas can also be copied using the Fill Handle. The formulas in cells 
B9 and F4 can be copied in this way to save re-typing. 

13. With the active cell as B9, drag the Fill Handle across to F9. 

 

Note: E9 will show the sum of column E and F9 will show the sum of column F although 
column F is incomplete at the moment. 

Note: The AutoFill Options Smart Tag, , appears. This allows different formatting 
to be selected. Performing any other unrelated action removes it. 

14. Click in cell E9 and check the Formula Bar to see that the formula has 
been updated automatically to sum column E instead of column B. 

15. To complete column F make the active cell F4 and drag the fill handle down 
to F8. The completed spreadsheet should look the same as below. 

 
16. Save the workbook using the same file name. 

17. Leave the workbook open for the next exercise. 



Excel 2007 CLAIT Plus 

 43 © CiA Training Ltd 2007 

Exercise 21 - Checking Formulas 

Guidelines: 

Spreadsheets are of little use if the formulas within them contain errors. All 
formulas should be checked to make sure that they are accurate. 

Actions: 

1. The workbook Sandwiches2 should still be open from the previous 
exercise. If not, open it. 

2. To check the formula in cell F4, click on the cell and check the formula in 
the Formula Bar, it should be =SUM(B4:E4). 

3. A much better way to check a formula is to double click on the required cell. 
Double click on cell F4. The formula is displayed in the cell with colour 
coding to show which cells are used. 

4. After checking, press <Enter> or <Esc> to finish the editing. 

5. Double click on cell F9. The range is shown in blue. Click and drag the blue 
range border down to start at row 12, which moves the range being 
calculated in F9. 

 

Note: As well as moving the range it can be adjusted by moving the mouse pointer over 
one of the corner arrows and clicking and dragging the border. 

6. Click and drag the border up two cells, using the right corner, so 
the range only includes three cells. 

7. Move the range back to the correct position starting on row 4 (it 
will be two rows short). Press <Enter> to complete the formula. 

8. Double click on cell F9 and adjust the range to include F7 and F8 as before. 

9. Save the changes using the same name and close Sandwiches2. 
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Exercise 22 - Revision 

1. Start a new workbook. 

2. The illustration below shows the number of high-tech components 
produced in a week by the different plants of a precision engineering 
company. Create the following worksheet. 

 

3. In cell F5, use AutoSum to work out the total number of Wottnotts 
produced across the four plants. 

4. In cell B9, calculate the total output of the Northern plant for the week. 

5. Use the Fill Handle to replicate the formula in F5 down to F8. 

6. Copy the formula in B9 across to F9. 

7. What was the total production of the Southern plant in that week?  

8. How many Doodahs did the four plants produce between them during the 
week?   

9. What was the total output for all four plants?  

10. Save the workbook as Engineering. 

11. Close the workbook. 

 Note: The answers for this exercise are listed in the Answer Section at the end of the 
guide. 


